# Table of Contents

1 **Repstor affinity** .............................................................. 5  
   1.1 Software Requirements .................................................. 5

2 **Key Features of Affinity** ..................................................... 6  
   2.1 Adding a Search Scope ................................................... 8  
   2.2 Adding Repositories ..................................................... 9  
   2.3 Filing in Repositories ................................................... 12  
      2.3.1 Jump to Folder ....................................................... 13  
      2.3.2 Quick File ........................................................... 14  
      2.3.3 Quick File Attachments ............................................ 14  
   2.4 Adding New Content to Repstor affinity Folders .................. 15  
      2.4.1 From Outlook ....................................................... 15  
      2.4.2 From Word, Excel and PowerPoint .............................. 16  
      2.4.3 From Files Explorer ............................................... 16  
      2.4.4 Using Add Document ............................................... 17  
   2.5 Synchronization and Expiry of Content ............................. 18  
      2.5.1 Regular content synchronization ................................ 18  
      2.5.2 Synchronization at different Levels ............................ 19  
      2.5.3 Expiry of Content ................................................ 20  
      2.5.4 Synchronizing Changes to Documents and other Files ...... 21  
   2.6 Accessing and Reusing Filed Content ................................ 22  
   2.7 Luggage Tags ............................................................. 24  
   2.8 Affinity Options in Office Applications ............................. 26  
   2.9 Quick File Online ...................................................... 27  
   2.10 Placeholders ............................................................. 28  
      2.10.1 Creating Placeholders .......................................... 28  
      2.10.2 Adding and Editing Placeholders .............................. 30  
      2.10.3 Using Placeholders in Documents and Templates .......... 31  
   2.11 Custom Views for Repstor affinity Folders ...................... 32  
      2.11.1 Custom Views Pushed out by System Administrators ...... 35

3 **New Features in Affinity 4.0** .............................................. 37  
   3.1 Online Search for SharePoint Online ................................ 37  
   3.2 Search for Properties from within Outlook ......................... 39
3.3 Limit the synchronization to a certain number of days ...................................... 40
3.4 Prevent Auto-preview for Files that Exceed a Size Limit .................................. 40
3.5 Online Preview for Large Files that Exceed a Size Limit .................................. 40
3.6 Download Progress in Outlook Reading Pane .................................................. 41
3.7 View Sync Status Message in the Outlook Reading Pane .................................. 42
3.8 Synchronization in Progress-Alert ...................................................................... 44
3.9 Document Updated on Server-Alert ..................................................................... 44
3.10 Offline-Alert .......................................................................................................... 44
3.11 Delay in Background Synchronization .................................................................. 45
3.12 Add Favorite Locations ....................................................................................... 45
3.13 Permission-Error Messages ................................................................................ 47
3.14 Keyboard Shortcuts .............................................................................................. 47

4 Repstor affinity Menus and Tab ................................................................. 48
   Home Tab .................................................................................................................. 48
   Repstor Tab .............................................................................................................. 49
   Folder Tab ................................................................................................................ 51
   Repstor affinity (Folder) right-click menu .............................................................. 52
   Repstor affinity (document) right-click menu ......................................................... 54
   Affinity Commands in an Email Draft ...................................................................... 55

4 Repstor affinity-Options Dialog ................................................................. 57
   General Tab .............................................................................................................. 57
   View Tab .................................................................................................................. 58
   Search Scopes tab .................................................................................................. 58
   Repstor assist tab .................................................................................................. 59
   Cache Management tab .......................................................................................... 59
   Advanced tab ........................................................................................................... 60
   Managing General Configuration Settings for Repstor affinity ......................... 62
   Managing Repository Views .................................................................................. 64
   Adding a Search Scope ............................................................................................ 65
   Configuring Quick File and Categorization Settings ............................................. 66
   Managing Content Expiry Settings ......................................................................... 67

4 Repstor affinity Hints and Tips ................................................................. 69
1 Repstor affinity

Repstor affinity is a multi-repository email, document and file management application for Microsoft® Outlook. Affinity provides uninterrupted access to content repositories from within the familiar Outlook- interface. You can access content in SharePoint systems or File Shares online and offline to add, view, or edit content. Your permissions in Repstor affinity depend on your permissions to access and edit the content in the source system. Affinity synchronizes any changes to the content repository, and you can continue to work without waiting for slow downloads from and uploads to content stores. In addition to SharePoint, Affinity supports other content stores including, M-Files, Dropbox, Box, Content Manager, iManage WorkSite, Meridio, HighQ, and Dynamics CRM.

1.1 Software Requirements

The required software components for Repstor affinity are as follows:

- Microsoft Windows 7 or later
- Microsoft Office 2010 or later


## 2 Key Features of Affinity

Repstor Affinity has many features, some that all users can use and others that only System Administrators will use. The following are the Key features.

**Seamless Integration with Outlook**

Repstor affinity installation allows you to use Outlook to access content located on SharePoint or File Shares while online or offline. A **Repstor affinity** top-level folder appears in the Outlook Folder Pane in the same level as your mailbox. The content store repositories that you add or are pushed out to you appear as folders under this top level **Repstor affinity** folders.

You can drag and drop email and documents into SharePoint libraries and other repositories from Outlook. Drag and drop emails, email attachments and documents into the repositories that appear as folders under the **Repstor affinity** Outlook folder. The [Outlook Ribbon Bar and Menus](#) include options and commands that will help you find, access, update and file information.
Adding Repositories

To start working with content share repositories from Outlook, you must add repositories to the Repstor affinity folder in Outlook. Repstor affinity connects to SharePoint instantly but has connectors to connect to other content stores. Go to the Repstor Getting Started page to install these connectors and add relevant repositories to Outlook.

- Your administrator can use the Central repositories list to add repositories that you can access in Outlook.
- With suitable permissions, you as an individual user can add repositories manually. To do this, you must first set search scopes.
- With suitable permissions, you as an individual user can add repositories manually through Add Repository dialog.

Easy Addition of Content

You can drag and drop emails, email attachments and documents into SharePoint libraries and other repositories that appear as folders under the Repstor affinity Outlook folder. In addition, Affinity adds features to Outlook which work both on affinity and on Outlook standard folders. These make filing in repositories quick and simple. You can avoid browsing through a folder hierarchy with many folders and use the Repstor assist filing options. You can add content to your Repstor affinity folders from outlook, from within Microsoft applications or from the Files explorer.

Full Offline Functionality and Online Synchronization

You can access, add and edit content when you are offline (disconnected from SharePoint). Synchronization occurs automatically when you are connected to SharePoint and Outlook is running. The newly synchronized content appears as unread items in the Outlook folder. To know more about synchronization click here.

Update Content Filed in Repositories through Outlook

You can preview content from the repository using the Preview pane in Outlook. You can also search for, access and reuse filed content from your Outlook. To know more, click here.

Luggage Tags

You can use luggage tags to automatically file replies to emails that you send and file to Repstor affinity folders. The luggage tag is a unique alpha-numeric code that identifies a Repstor affinity folder in Outlook. The luggage tag is generated when you Send and Tag a draft email and select the folder to file the sent email. Emails you receive with the luggage tag in the subject are automatically filed to the same folder. Click here to know more about luggage tags.

Quick File Online

You can use the Switch to Online feature available in the Quick file dialog to file to folders in SharePoint and other repositories, that are not already synchronized in Repstor affinity folder. Click here to know more.
Affinity Commands in Office Applications

Repstor affinity installation brings in additional Repstor affinity commands in the Microsoft Applications like Word, Excel and PowerPoint. These commands make accessing and saving content in repositories very simple.

Placeholders

Placeholder functionality provides an easy-to-use document generation capability allowing you to insert document information through properties defined in a SharePoint list. Placeholders are snippets of reusable information that you can include at one or more places within a document. It can include, customer name, sender name and email, Task to do, department code etc. If you are a system administrator, you can set the placeholders list as read-only for users or with permissions to edit. You can give users access to multiple placeholder lists. To know more click here.

2.1 Adding a Search Scope

Search scopes are often defined and pushed out by your administrator. You can also, as an individual user add a search scope. Search scopes are useful if you want to manually add repositories.

To add a Search Scope

1. In Outlook, click the Repstor tab and then click Options. The Repstor affinity- Options dialog appears.
2. Click the Search Scopes tab.
3. In the Name box, type a name for your search scope.
4. In the Type of repository drop-down, click the type of repository you want to add. For example, Box, Meridio, High Q, HPRM etc. The drop-down list options depend on the content stores you are connected to.
5. The name of the next text box changes depending on the repository type you selected, type the URL for the location of the repository.

6. Click Add.

7. Click Apply.

8. Click OK.

### 2.2 Adding Repositories

You can add repositories under the Repstor affinity folder. In many cases your IT department or administrator will add content repositories to your configuration, and you can expand the Repstor affinity folder in Outlook to view the folders below that level.
Depending on your permissions, you can add SharePoint repositories to your Outlook environment in one of the following ways:

**To Search and Add Repositories when Search Scope is Set**

**Note** You must have **added a search scope** already to complete this procedure.

- In Outlook, in the **Repstor** tab, select **Repositories** and type the first few letters of a repository and click **Search**. In the list that appears, click a repository and then click **Add Repository**.

![Search for Repository to Add - Repstor affinity](image)

Manually add Repositories without using search scope

1. In Outlook, in the **Repstor** tab, select **Repositories>Search>Manage Repositories**.

2. Click **Add**

3. In the **Type** drop-down, click the type of repository you want to add.

![Add Repository](image)

4. If necessary, in the **Parent Group** box, type a parent folder which will help create a virtual folder structure. You can define multiple levels of parent folders using colons (:) in between.
5. By default, download preferences are inherited from the global settings in **general tab of the Repstor affinity-Options dialog**. However, you can specify an explicit preference for this repository. To do so, in the Download Preferences drop-down list, click one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Folder Synchronization behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Items</td>
<td>All items, including metadata and content, are downloaded from the server and stored in the user’s local machine cache.</td>
</tr>
<tr>
<td>Headers Only</td>
<td>Headers only (e.g., metadata stubs) are downloaded from the server and stored in the user’s local machine cache.</td>
</tr>
<tr>
<td>Headers, then Full Items</td>
<td>Headers only (e.g., metadata stubs) are downloaded from the server initially, and once downloaded are then replaced with the full content.</td>
</tr>
<tr>
<td>No Downloads</td>
<td>No content or metadata is downloaded from the folder. Designed to allow quick filing of content to a folder without syncing its content to the local machine.</td>
</tr>
<tr>
<td>Online Only</td>
<td>Folder hierarchies are downloaded; headers only are downloaded on demand as users browse through the folder hierarchy. Content is not downloaded.</td>
</tr>
<tr>
<td>Folder only – no sub folders</td>
<td>No content or metadata is downloaded from the server. Designed to allow quick filing of content to a repository without syncing its content to the local machine, if a folder contains sub folders, the sub folders are not available.</td>
</tr>
</tbody>
</table>

6. In the **Location** box, type the URL for the location of the folder and click **OK**.

**To add Repositories from the SharePoint interface**

- In the Classic SharePoint view, click a folder you want to add and then click **Connect to Outlook**.

- In the Classic SharePoint view, right-click a folder you want to add and select **Advanced>Connect to Client or Connect to Outlook**.
2.3 Filing in Repositories

To make filing simple and quick, affinity adds a couple of features to Outlook which work both on affinity and on Outlook standard folders. You can avoid browsing through a folder hierarchy with many folders and use the Repstor assist filing options available in the Home tab.
Note  The label varies (Red for assist and Grey and Red for assist Lite) depending on your licenses.

2.3.1  Jump to Folder

1. In the Home tab, in the Repstor assist area, click Jump to Folder. The Jump to Folder dialog appears.
2. In the Search for Folder box, type the first few letters of the folder path.

Any matching folders appear as results (‘cus’ in the image above).

3. Type a few more letters after a space to narrow down your search.

4. Under Results, double-click a folder or click a folder and click Open. The contents of the folder appear in Outlook.
2.3.2 Quick File

Quick File files the email or item you select in your desired location.

1. In the Home tab, in the Repstor assist area, click Quick File. The Quick file dialog appears.
2. In the Search for Folder box, type the first few letters of the folder path.

Any matching folders appear as results.

You can type a few more letters after a space to narrow down your search.

3. Under Results, double-click a folder or click a folder and click Move. The email or item is filed in the folder.

You can click Copy to file a copy of the email in the folder instead of moving it to the folder.

The Quick File function also suggests locations where the document or email can be filed based on its content.

2.3.3 Quick File Attachments

Quick File Attachments is simply a Quick File for emails with attachment. The important difference is that Quick File Attachment copies (instead of moving) to your desired location, this means that
the original emails are left unchanged. You can save all attachments in a single location or choose different locations for different attachments.

1. In the Home ribbon, in the Repstor assist area, click Quick File Attachment. The Select a Folder dialog box appears.
2. In the Search for Folder box, type the first few letters of the folder path.

   Any matching folders appear as results.

   You can type a few more letters after a space to narrow down your search.

3. To move all attachments to one location, under Results, double-click a folder or click a folder and click Select. The attachments are moved to the folder.

4. To move attachments to different separate locations, click on an attachment and then right-click to select Quick File Attachment.

---

**2.4 Adding New Content to Repstor affinity Folders**

You can add content to your Repstor affinity folders from Outlook, from within Microsoft applications or from the Files explorer.

**2.4.1 From Outlook**

- To copy to a new location, select one or more items in Outlook, right-click drag and drop in new location.

  You can Press CTRL+C or right-click and click Copy and in the new location Press CTRL+V or right-click and click Paste.

- To move to a new location, select one or more items in outlook, click drag and drop. You can use Quick file to move multiple items.
Note You may have to complete a property form that appears with mandatory properties marked with a *.

• To move or copy a hierarchy of information from standard mail folders, right-click on a folder and click Copy folder or Move Folder. In the dialog box that appears, click a target location under Repstor affinity.

Note Large hierarchies may take some time to synchronize back to the SharePoint system.

2.4.2 From Word, Excel and PowerPoint

Within the Microsoft application, click and the Quick File dialog appears, where you can choose a folder to save it in. You can give the document a file name as you save it.

2.4.3 From Files Explorer

• To copy to a new location, select one or more items in the Files Explorer, right-click drag and drop in a Repstor affinity folder in Outlook.

You can Press CTRL+C or right click and click Copy and in the new location Press CTRL+V or right-click and click Paste.

• To move to a new location, select one or more items in the Files Explorer, click drag and drop in a Repstor affinity folder in Outlook.

Note You may have to complete a properties form that appears with mandatory properties marked with a *.

• To add a hierarchy of information from the Files Explorer, right-click on the target folder under Repstor affinity and select Repstor affinity>Import Folder in the Files Explorer that appears, select a folder to import.
2.4.4 Using Add Document

You can add single items using the Add Document in Outlook when accessing a Repstor affinity folder. If content types are configured, you can choose any of the allowed types.

This opens Files Explorer window where you can choose a single file. When you choose a file, the Properties dialog appears, where you must fill any mandatory properties and can change the name of the file.
2.5  Synchronization and Expiry of Content

Initial synchronization of content takes place in the background when you open Outlook for the first time after affinity installation. Initial synchronization can take more than a few minutes depending on the number of folders and items and their size. All the folders and documents in the folder structure including all sub-folders are synchronized. After initial synchronization, synchronization occurs automatically when Outlook is running and does not occur when Outlook is not running. The Group Policy usually defines the interval in which document repositories are synchronized. During automatic synchronization, folders are queued for synchronization on a schedule.

Note  You can access any content before the initial synchronization is complete. Click Repstor affinity on the Outlook Folder Pane and navigate the folder structure to go to the folder you want. The folders below the top level reflect the folder structures and content in any configured repositories. As you click on the nodes in Outlook and navigate the folder structure, each level is synchronized.

2.5.1  Regular content synchronization

When you add content to an affinity folder.

Every time you add content to an affinity folder, the contents of that folder are synchronized. Any new content in the folder and any new folders under it appear as unread items.

Warning  When collaborating with others to produce a document, you may need to wait a few seconds after moving to the folder so that the new content is synchronized.

When you click folders to browse through them.

The folders are queued for immediate synchronization. This keeps all folders up to date in the system, while prioritizing frequently accessed folders.

Automatic background synchronization.

By default, affinity synchronizes any new or changed content in the background, every hour. You can change this schedule through a Group Policy setting.

When you synchronize a folder manually as follows:

- Right-click a folder and click Properties. In the Properties dialog box, click Repstor affinity > Queue for Synchronization.
Right-click a folder Repstor affinity > Sync Now

When you synchronize the complete hierarchy manually.

Click the Repstor tab > Sync Now.

2.5.2 Synchronization at different Levels

Synchronization for individual repositories is defined using the Central repositories or using the following procedure.

1. In Outlook, in the Repstor tab, select Repositories > Search > Manage Repositories.
2. If the repository you click is set to synchronize regularly, the **Disable** button appears, if not the **Enable** button appears.

**Overall Background Synchronization is set in the Repstor affinity options – dialog.**

1. In Outlook, select **Repstor tab>Options>General tab**.
2. Select the **Schedule regular synchronization of all active repositories** check box.
   
   Clear the check box to stop all background synchronization.

**Simple on/off synchronization setting**

This disable both background and synchronization of folders as they are accessed. This is useful for circumstances where the user is on a connection where data is paid for on a meter.

You can explicitly synchronize individual folders using **Sync is Enabled** in the Repstor tab

2.5.3 **Expiry of Content**

By default, Repstor affinity expires content after 30 days. This means that if a folder was not accessed in the past 30 days then the local copy of the files is removed from the local system. Eventually, the regularly accessed content is kept synchronized. You can change this setting using **Cache Management** in the **Repstor affinity- Options** dialog box.
2.5.4 Synchronizing Changes to Documents and other Files

- If you are online and have edited a document or updated properties, the changes are synchronized when you close the application (e.g. Word or Excel) or close the property panel.
- If you are offline, changes are synchronized as soon as possible when the network and repository are available.
- If you edit an item in an Office application and save the document without closing the document in the application, changes are saved locally, and synchronization happens only after you close the document.

When your changes are synchronized, the item is marked as unread in the main view to indicate that synchronization is complete and successful.

You can see use All Repositories in the Repstor Tab in Outlook to view pending changes.
This image above shows that in the current folder there are no changes awaiting upload or documents being edited. There are four items that are either being edited or are awaiting upload in all the synchronized folders.

Click **Pending Changes** to view list of pending changes (these may be items that are currently being edited or items that have been amended and are ready for upload.)

### 2.6 Accessing and Reusing Filed Content

Click a Repstor affinity folder in Outlook and the contents of the folder are available in the Outlook email list view.

Freshly synchronized content appears like unread messages. Click a document and you can view it in the preview pane of the Outlook.

**To perform an Outlook Search for Filed Content**

1. In the **Repstor affinity** folder, click the repository you want to search in.
2. In the Outlook Search area, type what want to search for.
3. Contents that match your search phrase appear high-lighted.

To View and Edit Documents

1. For filed email, you can use the standard Outlook functions such as Reply, Forward, Attach items.
   For documents, you can also use these commands in the preview/ reading pane.

2. To open the document in read-only mode, click View Document.
3. To edit document in the relevant application, click Edit Document.

To Co-Author a Document

Co-Authoring, (when enabled) allows you to edit the document directly in SharePoint alongside other users simultaneously.

1. Click Edit Document for a document you want to edit, if another user is currently editing it, the following message appears.

2. Click OK and then click Co-Author, the document opens in the relevant Office Application.
A message appears giving the name of the user currently editing the document.

The place in the document that the other user edits appears high-lighted for you and the place you edit appears highlighted for the other user.

**To Share a Document from within Outlook.**

1. In the Repstor affinity folder, click a folder and click a document to share.
2. Click **Send Link**. A new email appears with a link to the document, which you can send to recipient.
3. The recipient can click the link to view the documents. Editing requires permissions you must grant before you send the link.

**To grant permission for the recipient to edit the document**

1. In the Repstor affinity folder, right-click a folder that contains the document.
2. In right-click menu, select **Open Location**. The folder opens in its actual location in a web browser.
3. Set the permissions in your content store.

### 2.7 Luggage Tags

You can use luggage tags to automatically file replies to emails that you **send and file** to Repstor affinity folders. Use the following registry settings to configure luggage tags.

- Assist.LuggageTagFirm (string)

  Two or three-character code that identifies your firm/company. For example, REP for Repstor.
• **Assist.LuggageTagProperty (string)**

A unique property identifying the location to file to. For custodian pinned items, the provisionable code is a rational setting to use for this registry setting. If it is pushed through central repositories list (CRL), add a **Luggage Tag** column to the CRL.

• **Assist.LuggageFolderHints (string)**

This setting identifies the folder to file to when the luggage tag applies to many folders. For example, if HV-00001 is the luggage tag for all folders under a site, set **Assist.LuggageFolderHints to ‘correspondence’** to ensure that the tagged emails are filed to the **Correspondence** folder.

**To use Luggage tags**

1. Create a new draft email and click **Send and File**.
2. In the **Select a Folder** dialog, click the folder for which you set the luggage tag.

![Select a Folder dialog](image)

3. Click **Send and Tag**.
4. The email is sent with a tag in the subject line. (HV-00001 in the image below)

![Email with tag](image)

5. The sent email is filed in the folder associated with the tag.
6. Replies to the email which include the luggage tag in the subject line are automatically filed in the same location.

7. When you reply to or forward an email with a luggage tag, to remove the luggage tag, click **Remove Tag**.
### 2.8 Affinity Options in Office Applications

When you install Repstor affinity the following commands appear in the Home tab in Word, PowerPoint and Excel.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open from Repstor affinity</td>
<td>Opens the Select items dialog using which you can open a document from one of the available repositories.</td>
</tr>
<tr>
<td>Save as new Repstor affinity Document</td>
<td>Opens the Quick File dialog where you can choose a repository to save the document in. You can give the document a file name as you save it.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Insert Document Link</td>
<td>Opens the Select items dialog showing the documents you accessed recently in the locations you accessed recently.</td>
</tr>
<tr>
<td>Send Document Link</td>
<td>Opens an email (which you can send to recipients) with the link to the current document.</td>
</tr>
<tr>
<td>Save and Sync</td>
<td>Saves the current document you are using and syncs your changes to the repository.</td>
</tr>
</tbody>
</table>

### 2.9 Quick File Online

You can use the following registry settings and procedure to configure Quick File Online.

- ROAM.ShowOnlineFileButton (DWORD = 1)
- ROAM.SearchScopeForOnlineFiling (String="name of the configured search scope ", for example, "SharePoint")

1. Click an email and then click **Quick File**. The Quick File window appears.
2. In the **Search for Folder** box, type the first few letters of the folder you want to file in.
3. To file in a folder not already available in your Outlook, click **Switch to Online**. The matching online folders appears.
4. In the **Results** area, click the folder you want and click **Move** or **Copy**.

The online folder you selected is automatically added under an **Uploading folder** in **Repstor affinity**. You can file additional emails in the dynamically added folder. By default, when you restart Outlook, the dynamically added folder is removed automatically.

### 2.10 Placeholders

#### 2.10.1 Creating Placeholders

1. In a SharePoint site, create a custom list with two columns Title and Value. The list is called **Default Properties** in the example below.

   ![Default Properties](image)

   ![Columns](image)

   The address bar in your web browser will read like the following example


   **Note**  You can create multiple SharePoint lists to use as placeholder lists.

2. Copy the URL for the list. For example

   https://repstor.sharepoint.com/sites/gwen/Lists/Default%20Properties

3. Go to the registry settings in **HKEY_CURRENT_USER\Software\Repstor\Repstor Affinity**

4. Add a string setting called **UserSettingRepositories.Locations**.
5. In the Value data box type in the following format

:::<Repos Type> :::<URL to list>:::<Name for affinity>:::<Parent Folders>

For example,

Placeholders:::Placeholders

6. If you have multiple placeholder lists, in the Value data box type in the following format

:::<Repos Type>:::<URL to list>:::<Name for affinity>:::<Parent Folders><TAB>:::<Repos Type>:::<URL to next list>:::<Name for affinity>:::<Parent Folders>

For example,

:::SharePoint:::https://repstor.sharepoint.com/sites/clients/Lists/User Settings:::User
Placeholders:::Placeholders
:::SharePoint:::https://repstor.sharepoint.com/sites/clients/Lists/Department Settings/:::Department
Placeholders:::Placeholders

7. Restart Outlook.

You can see a User Placeholders list in Repstor affinity beneath a parent Placeholders folder. Affinity automatically picks this list up to provide placeholder properties to any document you edit within affinity.

**Note** If you created multiple SharePoint, you will see multiple lists beneath the parent Placeholders folder.
2.10.2 Adding and Editing Placeholders

If you have permissions to edit and add to the corresponding SharePoint list, you can add new placeholders and edit existing placeholders from within Outlook.

To Add Placeholders

1. Click **User Placeholders** list in Repstor affinity beneath the **Placeholders** folder.
2. In the Outlook Home tab, in the **Repstor affinity** area, click **Add document** and then click **Item**.
3. In the Properties window that appears, type the Title and Value for the new placeholder.
4. Click **Save and Close**. The new placeholder is added to the list of placeholders.
To Edit Placeholders

1. Click **User Placeholders** list in Repstor affinity beneath the **Placeholders** folder.
2. Double-click the placeholder you want to edit. A properties window with the name of the placeholder appears.
3. Edit the Title or Value or both for the placeholder.
4. Click Save and Close.

2.10.3 Using Placeholders in Documents and Templates

To Insert Placeholders in Documents

You can insert placeholders and update placeholders into any document in Repstor affinity. Use the commands available in the **Insert** tab in Word.
Placeholder Commands in Word

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Placeholder</td>
<td>Inserts the Title for the placeholder. For example, [User.Sender] : [User.Target User]</td>
</tr>
<tr>
<td>Update placeholder</td>
<td>Updates the title to show the value for the placeholder.</td>
</tr>
<tr>
<td>Note</td>
<td>You can use this command only if you first use the Insert Placeholder.</td>
</tr>
<tr>
<td>Insert Property</td>
<td>Inserts the value for the placeholder directly without using or showing the Title.</td>
</tr>
</tbody>
</table>

To Insert Placeholders in Word templates

You can also insert placeholders into Word templates. Use the Word template to create new documents and then update the placeholders.

1. Open a Word Document and save it as a Repstor affinity document using.
2. In Outlook, in Repstor affinity, click the document you just saved.
3. Click Co-Author

   Caution  Placeholders are not available if you use Co-Author

   The document opens in Word with the placeholder commands available in the Insert tab.
4. Insert placeholders using the Insert Placeholder command.
5. Save the document as a Word template (.dotx).
6. Save with a new file name(.docx)
7. Click Update Placeholders.

2.11 Custom Views for Repstor affinity Folders

Outlook views help you sort and group contents in an Outlook folder based on fields defined in Outlook. Repstor affinity allows you to create custom views for affinity folders using SharePoint,
Meridio, M-Files or Content Manager properties. You can create more than one Outlook view for an affinity folder and change between the views whenever necessary. That is, you can view the same Repstor affinity folder in different views using the Change View command in the Outlook View tab.

**Note** If your content store is SharePoint, your SharePoint views (in addition to the views you create in Outlook) are available under the Change View command in the Outlook View tab.

**To Create and Use Custom Views with Repstor affinity Fields**

1. Click a Repstor affinity folder in Outlook and the contents of the folder are available in the Outlook email list view.
2. Reduce the size of the preview pane, you can view the columns. For example, **From**, **Subject**, **Received** and **Size**.
3. Right-click on a column-header and click **Field Chooser**.
4. In the Field Chooser dialog box, in the drop-down list, click **User-defined fields in folder**.
**Note** The list of fields under **User-defined fields in folder** are Repstor affinity fields retrieved from the server.

5. Drag and drop a field to the column-header.

The field appears as a column in the view.

6. In the Outlook View Tab, select Change View > Save Current View as a New View.

7. In the Copy View dialog box, type a name for the view and click **OK**.
8. To use a custom view, click Change View and click of the available views.

### 2.11.1 Custom Views Pushed out by System Administrators

System administrators can push out custom views to users using xml files. A system administrator can create custom views using the previous procedure and use Outlook Spy to show and author the XML for the views. Affinity also allows system administrators to associate a Repstor affinity folder with a specific Outlook view. This means that every time a user accesses a Repstor affinity folder, the user will see the contents of the folder in the associated view.

**To create Custom Views and Match folders to Views (System Administrators Only)**

1. Save the XML files for custom views under Repstor\Repstor affinity\Custom Views. For example, Email View.xml and Document View.xml.

2. If necessary, add/remove custom columns in the XML files. You can also rename column names.

3. Use the ROAM.CustomFolderViews registry setting, to push out the stored custom views. You can use this setting without the next setting.

   **ROAM.CustomFolderViews** - String - Json array of xml files available as views.
   For example, ["Email View","Document View"] will load CustomViews/Email View.xml and CustomViews/Document View.xml

4. Use the ROAM.CustomFolderViewNames registry setting to match folders and custom views. This is dependent on the ROAM.CustomFolderViews setting.

   **ROAM.CustomFolderViewNames** - String - Json list of regular expressions as keys and view names as values. A view will be set to a folder, provided the folder name matches with the regular expression.
   For example, {".*emails.*":"Email View",".*documents":"Document View"} will set any folder
that contains "emails" to Email View and any folder that ends with "documents" to Document View.

**IMPORTANT** Leaving the last folder match blank sets the default for any folder that does not match an earlier entry.

5. In Outlook, when a user clicks a Repstor affinity folder and in the View Tab, clicks **Change View**. The views you saved as xml files appear.
3  New Features in Affinity 4.0

3.1 Online Search for SharePoint Online

You can use the Online Search feature to search from within Outlook for matching emails and documents in a section of the SharePoint (Online and 2019) or across all of SharePoint (Online and 2019). The system administrator must configure Repstor affinity and SharePoint for users to be able to access and use this feature. A Tech-note is available providing detailed steps to configure Online Search in SharePoint and Repstor affinity.

**IMPORTANT** If using SharePoint 2019, you must install and configure the Office Online Server to show search result previews.

**To Search for emails and Documents Online**

1. In Outlook, under Repstor affinity, right-click the folder you want to search and click Search Folder Online.

   Alternatively, click the folder you want to search and in the Home tab, click Search Folder Online.

2. In the Search bar, type a few characters of what you want to look up. All the matching contents available online in the selected folder appear in Outlook. The number of search results appear in the Repstor Refine Options in the Outlook Search tab and in the Repstor Online Results in the Outlook Home tab.

   You can click a document to view it in the Outlook Reading pane.
You can right-click any item and then click **Open Parent Folder** to go to the parent folder in SharePoint.

For modern Office format documents (.docx, .xlsx and .pptx), you can click **Edit Document** to launch the document for **Co-authoring** in SharePoint (Online or 2019).

3. To search using your search phrase against all the available SharePoint information, click ![Search All Items Online](image). Any items that match your search criteria appear highlighted in the search results.

The number of the results appear in the **Repstor Refine Options** in the Outlook **Search** tab and in the **Repstor Online Results** in the Outlook **Home** tab.

4. To send a document from the online search results as attachment, right-click it and click **Forward**. The document appears as a cloud attachment in a draft email if you are using Outlook 2016.

![Email Attachment](image)

For other versions of Outlook, the document is downloaded and attached to the email.

5. To bring the document Offline, in the reading pane click ![Bring Offline](image). A dialog appears with the name of the document you selected.

![Offline Document](image)

6. Replace it with a folder name and click **OK**. A **Documents** folder appears under **Repstor affinity** in Outlook with the document you brought offline in it. You can edit, view or send the document as a link.
You cannot file into this folder like any other Repstor affinity folder. If you right-click the folder and select Repstor affinity> Open Location the actual SharePoint location of the document opens.

### 3.2 Search for Properties from within Outlook

1. In Outlook, click the search bar and you can see an Outlook Search tab appear next to the Repstor tab.
2. Under Search for Property, click a property, for example DocId.
3. Enter a Document ID or part of a Document ID.

The documents that match appear in the search results and you can view the document, edit it or send as link.

You can use the standard Outlook search options like Sent To, Subject, From Date etc. to restrict the SharePoint results.

4. To add a column to your search results click Add Column and then click a property from the drop-down. For example, Doc id. A new column called DOCID appears in your search results.
3.3 Limit the synchronization to a certain number of days.

You can configure Repstor affinity for SharePoint to limit the information synchronized to a certain number of days, like seven days or ten days etc. To support this feature for document libraries and lists which exceed the list view threshold, add the Modified and Content Type columns as index columns.

Use the registry setting `ROAMSPSSync.LimitToRecentDay` (DWORD) and set its value to the number days you want to use as the limit.

If the value of the registry setting is 7 then, when you click any Repstor affinity folder in Outlook, you will see items accessed within the last seven days only. The default value is 0 which does not limit content at all.

3.4 Prevent Auto-preview for Files that Exceed a Size Limit

Typically, you can preview the documents saved in Repstor affinity folders in the Outlook reading pane. For SharePoint (Online and 2019), you can now prevent the auto preview of documents that exceed a certain size.

You can set a size limit using the registry setting `MaxAutoPreviewFileSizeMb` (DWORD). If the value of the registry setting is 5 then, when you access a document that is larger than 5Mb, you see the message **The document is too large to preview**.

You must use the **View Document** command to preview the document.

**Note**  If you set a limit for online preview as explained in the next section, ensure that the `MaxAutoPreviewFileSizeMb` registry setting has a higher value than the setting `MaxPreviewFileSizeMb`.

3.5 Online Preview for Large Files that Exceed a Size Limit

You can preview the documents saved in Repstor affinity folders in the Outlook reading pane. This is because the document is downloaded for you to preview. However, if a document is large the
preview is slow to appear. You can now use online preview to view large modern Office format documents (.docx, .xlsx and .pptx) stored in SharePoint (Online or 2019).

You can set a size limit using the registry setting MaxPreviewFileSizeMb (DWORD). If the value of the registry setting is 3 then, when you access a SharePoint Online document that is larger than 3Mb, you will see **Word, PowerPoint or Excel Online** appear in the Outlook reading pane briefly and then you can preview the document online.

**IMPORTANT** If using SharePoint 2019, you must install and configure the Office Online Server to show search result previews.

**Note** If you set a limit for auto preview as explained in the previous section, ensure that the MaxAutoPreviewFileSizeMb registry setting has a higher value than the setting MaxPreviewFileSizeMb.

### 3.6 Download Progress in Outlook Reading Pane

You can now view a progress bar in the Outlook reading pane as the document downloads from the server.

This is particularly evident when the download preference is set to Header only ad the documents are downloaded as you click the document in the email view.

When you click a document, it starts to download and a progress bar indicating the transfer appears as in the following image.

![Downloading document](image)

When you edit a document using **Edit Document** and save it, a progress bar indicating the transfer appears as in the following image.

![Uploading document](image)
3.7 View Sync Status Message in the Outlook Reading Pane

You can now view the sync status of documents in Repstor affinity folders in the Outlook Reading pane.

- In Outlook, under Repstor affinity, click a folder and click a document in the folder.

The Checking for updated document message appears in the reading pane.

![Checking for updated document message in Outlook reading pane](image)

To move through the documents in the selected folder, use the arrow keys in your keyboard or click with your mouse.

**Note** As you move through documents, the Checking for updated document message is always visible for two seconds before you can view the actual status for a document.

The possible status messages are:

- Editing document
- Uploading Document
- Document is up to date
- The document has been updated online. Click update to refresh this copy
- Synchronization Disabled
- Document is up to date. checked out to (name of the user the document is checked out to)

Here are some conditions under which you can see the status messages.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>You click</td>
<td>Document opens in the relevant application and the message in the Outlook reading pane changes to Editing document.</td>
</tr>
<tr>
<td>Edit</td>
<td>After editing and saving the document, click it in Outlook.</td>
</tr>
<tr>
<td>Document</td>
<td>The Uploading Document message appears, followed by the Checking for updated document message before changing in to Document is up to date.</td>
</tr>
<tr>
<td>You click Co-Author</td>
<td>Document opens online and you can edit it online. After saving your changes, click the document in Outlook. The following message appears.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Sync is disabled</td>
<td>Clicking a document in Outlook (that has not been previously downloaded) brings up the Synchronization Disabled message.</td>
</tr>
<tr>
<td>The document is checked out to another user</td>
<td>Click a document in Outlook and after two seconds the Document is up to date. checked out to (name of the user the document is checked out to) message appears.</td>
</tr>
<tr>
<td>The document fails to download</td>
<td>Clicking a document in Outlook brings up the following message.</td>
</tr>
<tr>
<td>The document is too large to download</td>
<td>Clicking the document in Outlook brings up the following message (after about two seconds):</td>
</tr>
</tbody>
</table>
3.8 Synchronization in Progress - Alert

If you try to edit, rename or open using a Microsoft application (from within Outlook) any document that is being synchronized in the background, the following message appears.

![Synchronization Alert](image)

When synchronization is complete, the message closes and you can edit, rename or open the document.

3.9 Document Updated on Server - Alert

If a document is edited by other users in SharePoint and you access it to edit, forward or convert it to pdf, the following message appears.

![Document Updated Alert](image)

You can click Yes to download and continue with the action you selected, for example, Convert to PDF.

3.10 Offline - Alert

If you are offline and from within Outlook you select a document and try to edit, forward or convert it to pdf, the following message appears.

![Offline Alert](image)

You can click Yes to edit the locally available document.
3.11 Delay in Background Synchronization

Whenever SharePoint’s health score exceeds a certain threshold, background synchronization is stopped for a set length of time. You can set this threshold for the SharePoint health score using the registry setting SharePointSync.HeathScoreThreshold(DWORD). The default value is 9. The time for which background syncing must stop is set using the registry setting SharePointSync.HealthScoreLightSyncDuration. The default value is 60 minutes.

In the Outlook Repstor Tab, click Sync Log to view the sync messages.

3.12 Add Favorite Locations

You can add favorite locations for filing, and they will appear in the Quick File dialog, Jump to Folder dialog and Select items- Repstor assist dialog.

1. In Outlook, click Quick File or Jump to Folder.
2. Right-click a location under Recent Locations and click Add to Favorites.
Alternatively, you can type a few characters to look for a location and, under **Results**, right-click a location and click **Add to Favorites**.

3. Your favorite locations always appear in the Quick File dialog, Jump to Folder dialog and Select items- Repstor assist dialog. You can expand your Favorite folders to view their child folders.

4. To remove a favorite location, right-click the location under **Favorite Locations** and click **Remove from Favorites**.
3.13 Permission-Error Messages

If your permissions change from the time you access to edit, move, copy or delete documents or messages, and the time you save to sync your changes, a relevant error message appears.

For example:
1. You click **Edit Document** in the Outlook reading/preview pane and start editing a document.
2. Your system administrator changes your permissions to Read-Only in SharePoint.
3. You save your changes.
4. Syncing begins but cannot be completed. A relevant permission error messages appears.

3.14 Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Function</th>
<th>Language and Shortcut</th>
<th>Dialog or Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select search field</td>
<td>English, Danish and German – Alt+S&lt;br&gt;French – Alt+C&lt;br&gt;Dutch – Alt+Z</td>
<td>Quick File, Jump to Folder, Attach Items and Send and File</td>
</tr>
<tr>
<td>Send Only</td>
<td>English and French-Alt+O&lt;br&gt;German-Alt+N&lt;br&gt;Danish-Alt+K,&lt;br&gt;Dutch-Alt+V</td>
<td>Send and File</td>
</tr>
<tr>
<td>Sent and Tag</td>
<td>Ctrl+Alt+T</td>
<td></td>
</tr>
<tr>
<td>Send and File</td>
<td>Ctrl+Alt+F</td>
<td></td>
</tr>
<tr>
<td>Quick File Move</td>
<td>Ctrl+Alt+M</td>
<td>Quick File</td>
</tr>
<tr>
<td>Quick File Copy</td>
<td>Ctrl+Alt+C</td>
<td></td>
</tr>
</tbody>
</table>
4 Repstor affinity Menus and Tab

When you install affinity, a Repstor affinity folder appears in the Outlook Folder Pane in the same level as your mailbox. Under this Repstor affinity Outlook folder, you can add repositories.

![Repstor affinity Menus and Tab](image)

**Home Tab**

In Outlook, there are additional commands available on the Outlook Home Tab when using items from the Repstor affinity folder than when using standard mail folders.

![Home Tab](image)

**Affinity Items in Outlook**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Respond</td>
<td></td>
</tr>
<tr>
<td>Forward and Track</td>
<td></td>
</tr>
<tr>
<td>Repstor affinity</td>
<td></td>
</tr>
<tr>
<td>Add Document</td>
<td>Allows you to add documents to the selected affinity folder (supports content types). You may have to fill any required properties, depending on the configuration.</td>
</tr>
</tbody>
</table>
### New Document
Allows you select an existing document type and add another of the same type with a new name.

### Repstor assist

### Jump to Folder
Allows you to identify and go to folders in the folder hierarchy (includes email and affinity folders).

### Quick File
Allows you to find the correct location and file single or multiple items in that location.

### Quick File Attachments
Allows you to find the correct location and file single or multiple attachments to that location.

---

## Repstor Tab

![Repstor Tab](image)

### Items in the Outlook Repstor Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repstor affinity</td>
<td></td>
</tr>
<tr>
<td>View Document</td>
<td>Opens the document or file in read-only mode in the relevant application.</td>
</tr>
<tr>
<td>Edit Document</td>
<td>Opens the document or file in the relevant application and allows you to edit it.</td>
</tr>
<tr>
<td>Rename</td>
<td>Allows you to rename a document.</td>
</tr>
<tr>
<td>Properties</td>
<td>Shows the document properties available.</td>
</tr>
<tr>
<td>Copy Link</td>
<td>Copies the link to the document, which you can paste into documents or emails. other users with relevant permissions can use the link to open the item.</td>
</tr>
<tr>
<td>Send Link</td>
<td>Opens a new email with a link to the document.</td>
</tr>
<tr>
<td>Repositories</td>
<td>Allows you to add, remove and manage repositories, provided you have the necessary permissions.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sync Log</td>
<td>Opens the synchronization log which shows the current synchronization activity.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Options dialog, where you can configure notifications, background synchronization, Central Repositories List and access advanced settings.</td>
</tr>
<tr>
<td>Repstor assist</td>
<td></td>
</tr>
<tr>
<td>View Text</td>
<td>Shows the text present in the selected message. Repstor assist uses this text for training the system to suggest filing locations.</td>
</tr>
<tr>
<td>Training Progress</td>
<td>Opens the Training Progress dialog, where you can view the date and time of the most recent training completion.</td>
</tr>
<tr>
<td>Repstor Sync</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>Sync Enabled</td>
<td>Indicates that synchronization is enabled.</td>
</tr>
<tr>
<td>Sync Now</td>
<td>Add the current folder and its sub folders to the sync queue. You can use this command only if sync is enabled.</td>
</tr>
<tr>
<td>All Repositories</td>
<td>Shows the number of local documents that are waiting to synchronize to the server or are being edited across all synchronized folders.</td>
</tr>
<tr>
<td></td>
<td>Click or point to the command to view more details of the status.</td>
</tr>
<tr>
<td>Selected Folder</td>
<td>Shows the number of local documents that are waiting to synchronize to the server or are being edited within the current folder.</td>
</tr>
<tr>
<td></td>
<td>Click or point to the command to view more details of the status.</td>
</tr>
</tbody>
</table>
Folder Tab

Items in the Outlook Folder Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync Now</td>
<td>Add the current folder and its sub folders to the sync queue. You can use this command only if sync is enabled.</td>
</tr>
<tr>
<td>Import Folder</td>
<td>Opens the Import Folder dialog where you can import folder and their sub folders from the desktop or file shares.</td>
</tr>
<tr>
<td>Open Location</td>
<td>Opens the source (SharePoint or other) in a web browser.</td>
</tr>
<tr>
<td>Copy Location</td>
<td>Copies to clipboard the URL of the source location.</td>
</tr>
<tr>
<td>Download Full Items</td>
<td>All items, including metadata and content is downloaded from the server and stored in the user’s local machine cache.</td>
</tr>
<tr>
<td>Clear Offline Storage</td>
<td>Clears offline storage for the selected folder.</td>
</tr>
<tr>
<td>Folder Properties</td>
<td>Opens the folder in the SharePoint or content store location.</td>
</tr>
<tr>
<td>Sort child folders by</td>
<td>Allows you to sort the child folders using sorting criteria.</td>
</tr>
</tbody>
</table>
**Repstor affinity (Folder) right-click menu**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
<td>Opens the Properties dialog where you can do the following for the current folder.</td>
</tr>
<tr>
<td></td>
<td>• Change download preferences.</td>
</tr>
<tr>
<td></td>
<td>• Clear offline storage</td>
</tr>
<tr>
<td></td>
<td>• Include the sub folders of the folder to queue for synchronization.</td>
</tr>
<tr>
<td></td>
<td>• Add the folder to the top of the queue for synchronization.</td>
</tr>
</tbody>
</table>

Repstor assist

[Diagram showing the Repstor affinity (Folder) right-click menu]

*Images and diagrams are not included in the natural text representation.*
<table>
<thead>
<tr>
<th>Training Process</th>
<th>Opens the Training Progress dialog, where you can view the date and time of the most recent training completion.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training Progress</td>
<td>You can click <strong>Updates Rules</strong> and manually update the rule.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Include in Training</th>
<th>Includes the selected folder in the Repstor assist training process and generates rules.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repstor affinity</td>
<td></td>
</tr>
<tr>
<td>Open Location</td>
<td>Opens the source (SharePoint or other) in a web browser.</td>
</tr>
<tr>
<td>Copy Location</td>
<td>Copies to clipboard the URL of the source location.</td>
</tr>
<tr>
<td>Sync Now</td>
<td>Places the folder at the top of the queue for synchronization.</td>
</tr>
<tr>
<td>Import Folder</td>
<td>Opens the Import Folder dialog where you can import folder and their sub folders from the desktop or file shares.</td>
</tr>
</tbody>
</table>
Repstor affinity (document) right-click menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Description or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick File</td>
<td>Allows you to find the correct location and file single or multiple items in that location.</td>
</tr>
<tr>
<td>Quick File Attachments</td>
<td>Allows you to find the correct location and file single or multiple attachments to that location.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the Files Explorer where you can select a folder in your local machine to save the document.</td>
</tr>
<tr>
<td>Item</td>
<td>Description or Action</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy Document ID</td>
<td>Copies the Document Id for the document.</td>
</tr>
<tr>
<td>Convert to PDF</td>
<td>Converts the document into a pdf file and saves in the same location.</td>
</tr>
<tr>
<td>Compare with previous version</td>
<td>Opens the compare-results file in Word with both the current and previous versions open.</td>
</tr>
<tr>
<td>Compare with Word Version</td>
<td>Opens the Select items dialog where you can select another word document to compare with and then opens the files in Word.</td>
</tr>
<tr>
<td>Rename</td>
<td>Allows you to rename the document</td>
</tr>
<tr>
<td>Edit Document</td>
<td>Opens the document or file in the relevant application and allows you to edit it.</td>
</tr>
<tr>
<td>Properties</td>
<td>Shows the document properties available.</td>
</tr>
<tr>
<td>Co-Author</td>
<td>Allows you to edit the document alongside other users simultaneously.</td>
</tr>
</tbody>
</table>

**Affinity Commands in an Email Draft**

Affinity Commands in an Email Draft

<table>
<thead>
<tr>
<th>Item</th>
<th>Description or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send and File</td>
<td>Opens the Select a folder dialog where you can select a folder to file the email you send. You can use <strong>Send and tag</strong> if you have luggage tags set up.</td>
</tr>
</tbody>
</table>
Attach Items

Opens the Select items dialog where you can search for content or documents you want to attach to the email.
4 Repstor affinity-Options Dialog

You can use the Repstor affinity Options dialog to manage general configuration options, manage repository views, configure Search Scopes, manage Repstor assist settings, manually change cache settings, and manage advanced synchronization settings.

In Outlook, click the Repstor tab and then click Options. The Repstor affinity- Options dialog appears.

General Tab

You can use the general tab to manage general configuration settings for Repstor affinity.
**View Tab**

You can use the View tab to manage repository views.

**Search Scopes tab**

Search scopes are often defined and pushed out by the IT administrator. You can also, as an individual user add a search scope. Search scopes are useful if you want to manually add repositories.
**Repstor assist tab**

You can use the Repstor assist tab to configure Quick File and Categorization settings.

![Repstor assist tab](image)

**Cache Management tab**

You can use the Cache Management settings to control the size of the cache on the local machine by expiring infrequently accessed content.

![Cache Management tab](image)
## Advanced tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description or action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advances Synchronization Settings (restart required)</td>
<td></td>
</tr>
<tr>
<td>Allow content deletion (and synchronize deletions)</td>
<td>Select the check box to allow users to delete content and sync their deletions.</td>
</tr>
<tr>
<td>Enable folders deletion and synchronize folder deletions to the server</td>
<td>Select the check box to allow users to delete folders and sync their deletions.</td>
</tr>
<tr>
<td>Use Finish button to synchronize local document edits</td>
<td>Select the check box to use the <strong>Finish Editing</strong> Button to synchronize the edits to a document.</td>
</tr>
<tr>
<td>Prompt on exit if pending messages remain unsynchronized</td>
<td>Indicates whether a prompt will appear when the user exits Outlook with synchronization pending.</td>
</tr>
<tr>
<td>Allow header only downloads</td>
<td>Indicates whether the <strong>Default download preferences</strong> drop-down is available in the <strong>General tab</strong>. Select the check box to make the drop-down available.</td>
</tr>
<tr>
<td>Category names to apply to field messages</td>
<td>Select the check box to add a category to any email filed to a repository.</td>
</tr>
<tr>
<td>Preview file max size</td>
<td>Maximum file size for preview. For files larger than the set size, use <a href="#">View Document</a> to view the document.</td>
</tr>
</tbody>
</table>

**Outlook Settings**
- Reset connect To Outlook
- Reset Search Folders

**Synchronization**
- **Sync Background Lists**
  - Synchronizes various background lists that contain property configurations and central repository lists.
- **Cancel Current synchronization**
  - Cancels the current synchronization task.
- **Diagnostics (restart required)**
  - Detailed diagnostics that affinity can generate to help diagnose user-issues.
- **Log Messages**
  - Select the check box to include information that will provide a context to the error messages.
- **Error Messages**
  - Select the check box to include error conditions that Repstor affinity encounters.
- **Service Calls**
  - Select the check box to include the details of information sent to and received from services.
Managing General Configuration Settings for Repstor affinity

1. To set the level for your windows notifications, in the Balloon Notifications area, use the slider to select a level.

2. To have the system check for changes to active repositories, select the Schedule regular synchronization of all active repositories check box.

   Clear the check box to stop all background synchronization.

3. Click the Default Download Preference list, and click one of the following:

   **Download Preferences and Sync Behavior**

<table>
<thead>
<tr>
<th>Option</th>
<th>Folder Synchronization behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Items</td>
<td>All items, including metadata and content is downloaded from the server and stored in the user's local machine cache.</td>
</tr>
<tr>
<td>Headers Only</td>
<td>Only headers metadata is downloaded from the server and stored in the user's local machine cache. Full item is only downloaded when the user accesses the item (clicks the folder)</td>
</tr>
<tr>
<td>Option</td>
<td>Folder Synchronization behavior</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Headers, then Full Items</td>
<td>Only headers metadata is downloaded from the server initially. The content is downloaded as a separate background task and full content replaces the header.</td>
</tr>
<tr>
<td>No Downloads</td>
<td>Folder structure is downloaded but no content or metadata is downloaded from the server. This allows quick filing of content to a folder without syncing its content to the local machine.</td>
</tr>
<tr>
<td>Online Only</td>
<td>Folder structure is downloaded. When users browse through the folder hierarchy, headers only are downloaded. After the Outlook session, the content is removed from the local cache. This can be used for large hierarchies of information that are needed on an ad-hoc basis.</td>
</tr>
<tr>
<td>Folder only – no subfolders</td>
<td>Folder structure is downloaded but no content or metadata is downloaded from the server. Designed to allow quick filing of content to a repository without syncing its content to the local machine. If that folder contains sub folders, these will not be made available to the end user.</td>
</tr>
</tbody>
</table>

4. In the **Duplicates** area, click one or more of the following check boxes.

**Check Boxes and Actions**

<table>
<thead>
<tr>
<th>Check box name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detect duplicates when adding duplicate messages to the same folder</td>
<td>Warns about duplicates.</td>
</tr>
<tr>
<td>Always discard duplicates in the same folder</td>
<td>Discard duplicates.</td>
</tr>
</tbody>
</table>

5. You can view the central repositories list at the bottom of the dialog.
Managing Repository Views

1. To synchronize repository views, select the **Synchronize repository view** check box.

2. In the **Synchronization Settings** area, select one or more of the following check boxes.

**Check boxes and Actions**

<table>
<thead>
<tr>
<th>Check box name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add view columns to Outlook Views</td>
<td>Creates equivalent views in Outlook containing fields from the source repository.</td>
</tr>
<tr>
<td>Set Group By values</td>
<td></td>
</tr>
<tr>
<td>Set sort Criteria</td>
<td>Generates view that include sort criteria.</td>
</tr>
<tr>
<td>Set filter criteria (limited support)</td>
<td>Generates view that include filter criteria.</td>
</tr>
<tr>
<td>Switch views on initial synchronization</td>
<td></td>
</tr>
<tr>
<td>To default view</td>
<td></td>
</tr>
<tr>
<td>To named view</td>
<td></td>
</tr>
</tbody>
</table>
Adding a Search Scope

Search scopes are often defined and pushed out by your administrator. You can also, as an individual user add a search scope. Search scopes are useful if you want to manually add repositories.

To add a Search Scope

1. In Outlook, click the Repstor tab and then click Options. The Repstor affinity - Options dialog appears.
2. Click the Search Scopes tab.
3. In the Name box, type a name for your search scope.
4. In the Type of repository drop-down, click the type of repository you want to add. For example, Box, Meridio, High Q, HPRM etc. The drop-down list options depend on the content stores you are connected to.
5. The name of the next text box changes depending on the repository type you selected, type the URL for the location of the repository.
6. Click Add.
7. Click Apply.
8. Click OK.

**Configuring Quick File and Categorization Settings**

- To configure the Quick File and Categorization settings, select one or more of the following check boxes.

<table>
<thead>
<tr>
<th>Check box name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy messages using Quick File rather than move</td>
<td>Copies messages to the filing location instead of moving them from your mailbox or current location.</td>
</tr>
<tr>
<td>Automatically prompt to Quick file email when sending</td>
<td>Opens the Quick file dialog to (enable filing) when you click Send emails.</td>
</tr>
<tr>
<td>Reindex Folders</td>
<td>Reindexes your Repstor affinity folders.</td>
</tr>
</tbody>
</table>

*Use this command when you receive the following message:

![Message](image)
<table>
<thead>
<tr>
<th>Check box name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suggest matching Repstor affinity documents for incoming email attachments</td>
<td>Analyzes incoming attachments to see if they return updates of documents sent out for review earlier.</td>
</tr>
<tr>
<td>Update training for folders daily when the computer is idle</td>
<td>Indicates that the folders are trained for filing suggestions when the computer is idle. By default, Repstor assist rules are kept up to date automatically once a day.</td>
</tr>
<tr>
<td>Enable training report generation</td>
<td>Allows you to generate a report to identify issues with content used for assist rules generation. To know more about assist, read the Repstor assist guide.</td>
</tr>
</tbody>
</table>

### Managing Content Expiry Settings

To set content expiry settings, select one or more of the following check boxes:

![Repstor affinity - Options dialog](image)

- **Expire Infrequently Used Folders**
  - Expire folders that have not been viewed or manually synchronized recently
  - Expire after: [days]

- **Minimize Local Storage**
  - This setting will automatically expire content within all folders after a short period of time and when closing Outlook.
  - Minimize Local Storage for all repositories

- **Disk Space Management**
  - Set the limit on disk space used by offline storage. Approaching this limit, folders will be expired more frequently.
  - Enable disk space limit: [20480 MB]
<table>
<thead>
<tr>
<th>Check box name (Content Expiry Type)</th>
<th>Description or action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expire folders that have not been viewed or manually synchronized recently</td>
<td>Expires contents of folders that were not viewed or manually synced for a specific number of days. You must specify the number days.</td>
</tr>
</tbody>
</table>
| Minimize Local Storage                                                                                                                                                                                        | Frequently expires content in your local cache. The default settings are:  
  • Expires contents 20 minutes after viewing a folder.  
  • Expires contents 10 minutes after moving away from a folder  
  • Expires contents of all folders when Outlook closes.  
  You can contact Repstor support to configure these settings through Registry configurations.                                                                                                                                                                                                                     |
| Disk Space Management                                                                                                                                                                                        | Disk space limit triggers expiry. You can set a disk space limit. When the disk space used reaches 80% of this limit, Repstor affinity expires content from folders that have been inactive recently.                                                                                                                                                                                                    |

To remove content of folders that expire from local cache and replace it with headers, select the **Expire to headers** check box.

**Note** Irrespective of content expiry type you use, you can select the **Expire to headers** check box to remove content of folders that expire from local cache and replace it with headers. This is not available for One Drive folders.
4 Repstor affinity Hints and Tips

Tips to use affinity effectively

<table>
<thead>
<tr>
<th>To</th>
<th>Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick refresh a folder</td>
<td>• Click <strong>Synch Now</strong>. Checks for updates and refreshes the current folder and its sub folders.</td>
</tr>
<tr>
<td>Check what is synching</td>
<td>• In the <strong>Repstor</strong> ribbon, click <strong>Sync Log</strong>.</td>
</tr>
<tr>
<td>Check when a folder was last refreshed</td>
<td>• Click a folder and point to <strong>Selected Folder</strong> in <strong>Repstor Sync Status</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Right-click a folder, click <strong>Properties</strong>, click <strong>Repstor affinity</strong> tab.</td>
</tr>
<tr>
<td>Use recently filed locations</td>
<td>• Click <strong>Jump to Folder, Quick File or Quick File Attachments</strong>.</td>
</tr>
</tbody>
</table>
**To** | **Do**
---|---
Add Repstor functions to the Quick Access Toolbar | 1. Select **File > Options**
2. In the Outlook Options dialog box, click **Quick Access Toolbar** and in the **Choose Commands from** drop-down, click **Repstor tab**.
3. Click the Repstor function you want and then click **Add>>**.

![Outlook Options dialog box](image1)

Send a link to the document instead of the document | 1. In Outlook, click the document and then click **Send Link**.
2. A new email with the link to the document appears, which you can send to the recipient.

![Send Link](image2)

Send a link to a folder | 1. In **Repstor affinity**, right-click the folder and select **Repstor affinity > Copy Location**
2. Paste the link in an email and send to the recipient.

![Repstor affinity Copy Location](image3)

To access the SharePoint | 1. In **Repstor affinity**, right-click the folder and select **Repstor affinity > Open Location**
2. The SharePoint location of the folder opens in a web browser.

![Repstor affinity Open Location](image4)